NUR4101
SYSTEMATIC LITERATURE SEARCHING

17th Aug 2018

Wong Suei Nee
NUS Medical Library
SO YOU WANT TO DO A SYSTEMATIC SEARCH?
BEFORE WE START

- View list of resources (listed in the list of resources during the Bridging workshop)
- Decide on a research topic
RE-CAP

After last session, you have learnt to:

1. Explain what is a ‘systematic’ review and why searching is important
2. Formulate a research question
3. Construct a search strategy
4. Do a scoping search in Cochrane, PubMed and Google Scholar
LEARNING OBJECTIVES

- After this session, you should be able to:
  1. Choose appropriate databases/tools
  2. Conduct a systematic search
  3. Document the search strategy
  4. Translate the search into other databases
Installing EndNote X8 on PC

Contact NUS IT Care (6516 2080, itcare@nus.edu.sg) for installation issues

http://libguides.nus.edu.sg/endnote
ENDNOTE LIBRARY

Where?

Back-up

How to move?

The Importance of the Data Folder:
https://youtu.be/HKbd-z-3MMc?list=PLEzzLdHScxiyWk5rBxgZt14OhIanoldv
TO START: CREATE A NEW LIBRARY

1. Search Windows > EndNote
2. Click on File > New
3. Enter a filename: My EndNote Test Library (.enl)
4. Select location to save the library (eg Desktop)
5. Click Save
DATABASE (CONTENT COVERAGE)

- PubMed
  - Clinical & medical topics
- Embase
  - Pharmacology & Toxicology
- Embase
  - Psychiatry & Psychology
- Cochrane Library
  - Specialised (Trials, Systematic reviews)
- CINAHL
  - Nursing, Alternative Medicine & Allied Health
DATABASE (TIME COVERAGE)

PubMed: 1946 - present

Embase®: 1974 - present

PsyclINFO® on Ovid®: 1887 - present

Cochrane Library: 1992 - present

CINAHL: 1937 - present
A LIST OF RESOURCES

Please refer to more information on LibGuide

- Database syntax guide for PubMed, Embase and Cochrane
- Cochrane
  - Browsing and Searching
  - Using MeSH and Search Manager
- Pubmed
  - Tutorials on PubMed
- EMBASE
  - Systematic searching in EMBASE
- CINAHL
  - Basic searching tutorial
  - Advanced searching tutorial
- PsycINFO
  - Searching in PsycINFO
EXPORTING SEARCH RESULTS DIFFERENT DATABASES

PubMed
https://youtu.be/mdwpSSNyG0k

Embase
https://youtu.be/VcJpb0YztkA

Scopus
https://youtu.be/alwH-ENkHIQ

Cochrane
https://youtu.be/QHXWaAZZBqE

CINAHL
https://youtu.be/R4mYFDO-qAU

Psycinfo
https://youtu.be/4qEh0HsBQGs

Library Subject Guide
LEARNING OBJECTIVES

After this session, you should be able to:

1. Choose appropriate databases/tools
2. Conduct a systematic search
3. Document the search strategy
4. Translate the search into other databases
EXAMPLE: SEARCH STRATEGY

Preventing childhood obesity in Asia: an overview of intervention programmes.

(child[MeSH Terms] OR child*[Title/Abstract] OR adolescent[MeSH Terms] OR youth*[Title/Abstract] OR adolescence*[Title/Abstract])

AND

(asia[MeSH Terms] OR asia*[Title/Abstract] OR japan*[Title/Abstract] OR chin*[Title/Abstract] OR hong kong*[Title/Abstract] OR singapore*[Title/Abstract] OR india*[Title/Abstract] OR malaysia*[Title/Abstract] OR korea*[Title/Abstract] OR indonesia*[Title/Abstract] OR thai*[Title/Abstract] OR vietnam*[Title/Abstract] OR lao*[Title/Abstract] OR cambodia*[Title/Abstract] OR myanmar*[Title/Abstract] OR burm*[Title/Abstract] OR sri lanka*[Title/Abstract] OR bangladesh*[Title/Abstract] OR philippines*[Title/Abstract] OR filipino*[Title/Abstract])

AND

(health promotion[MeSH Terms] OR promot*[Title/Abstract] OR intervention studies[MeSH Terms] OR prevent*[Title/Abstract] OR interven*[Title/Abstract] OR program*[Title/Abstract])

AND


OR fat-mass[Title/Abstract] OR composition[Title/Abstract] OR body size[MeSH Terms])
Video tutorials on Embase: (“Embase Systematic reviews” vs “Using PICO”)

How to begin EMBASE search (the 3S)
- Sign in, Seek help, go to PICO / Advanced Search
How to input Emtree terms and keywords in Embase

Find best term

Emtree
- groups by age and sex
  - juvenile
    - adolescent
    - child
    - juvenile animal
    - juvenile plant
  - groups by age

/exp - search strategy
Searches your term (or maps to the preferred Emtree term) and related narrower or children terms.

/mj Major focus
/de Index term
/exp Explosion
/br As broad as possible

Remove synonyms
Remove term

Study design (or miscellaneous)
e.g. randomized controlled trial

Reset query
Info
Show 3,296,820 results
How to input Emtree terms and keywords in Embase
How to input Emtree terms and keywords in Embase

10 synonyms
for obesity
adipose tissue hyperplasia
adipositas
adiposity
alimentary obesity
body weight, excess
fat overload syndrome
nutritional obesity
obesitas
obesity
overweight

Note: Filling any search line is optional

Population

juvenile /exp ↓ + 2 synonyms:tiab ↓ or ↓ obesity /exp ↓ + 10 synonyms:tiab ↓

or

Broaden your search by connecting tokens

and

or

not

next 2

near 2

Remove operator

Study design (or miscellaneous)

e.g. randomized controlled trial

Show 3,670,373 results
How to input Emtree terms and keywords in Embase
How to filter search results in Embase
LEARNING OBJECTIVES

- After this session, you should be able to:
  1. Choose appropriate databases/tools
  2. Conduct a systematic search
  3. Document the search strategy
  4. Translate the search into other databases
How to save and export search strategy in Embase
DIRECT EXPORT: EMBASE

1. Select records, then **Export**
GROUP DISCUSSION
(10 MIN)
LEARNING OBJECTIVES

- After this session, you should be able to:
  1. Choose appropriate databases/tools
  2. Conduct a systematic search
  3. Document the search strategy
  4. Translate the search into other databases
How to begin PubMed search (the 3S)

- Sign in, Seek help, Go to Advanced Search Builder
Three ways to locate MeSH database

1. **PubMed Homepage**
   - Click on the MeSH dropdown menu.

2. **More Resources**
   - Click on MeSH Database.

3. **PubMed Advanced Search**
   - Select MeSH Database from the list.
How to input MeSH terms & keywords in Advanced Search Builder

*Enter MeSH terms and keywords separately, one line at a time*

MeSH Terms search
https://www.youtube.com/watch?v=uyF8uQY9wys
Tip 1: Medical Subject Heading (MeSH)

Stroke
Infarction
Heart attack
Myocardial infarct
Myocardial infarction
Cardiovascular stroke

Video on PubMed Searching using MeSH:
https://youtu.be/uyF8uQY9wys?list=PLBD13A2628C7A9965
MEDICAL SUBJECT HEADING (MESH)

- Medicine's controlled vocabulary used for indexing articles for MEDLINE/PubMed
- Provides a consistent way to retrieve information

MeSH

```
MeSH  vaccination
```

Display Settings: Summary

Results: 3

1. **Vaccination**
   Administration of vaccines to stimulate the host's immune response. This includes prophylaxis.

2. **Mass Vaccination**
   Administration of a vaccine to large populations in order to elicit IMMUNITY. Year introduced: 2010 (2003)
Tip 2: Boolean Operators

**AND** is used to indicate that both terms must be present
- *e.g. caries AND sweets*
- *articles containing both caries and sweets*

**OR** is used to indicate that either terms maybe present
- *e.g. toothpaste OR dentrifrices*
- *articles containing either toothpaste or dentrifrices*
“Block Building”
Question: Is A related to B and C?

Apple
AND
Beetroot
AND
Carrot

A  AND  B  AND  C
SEARCH HISTORY / COMBINE SEARCH

Combine the two concept searches together

PubMed Advanced Search Builder

<table>
<thead>
<tr>
<th>Search</th>
<th>Add to builder</th>
<th>Query</th>
<th>Items found</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>#4</td>
<td>Add</td>
<td>Search &quot;Autistic Disorder&quot;[Mesh]</td>
<td>18682</td>
<td>06:07:19</td>
</tr>
<tr>
<td>#2</td>
<td>Add</td>
<td>Search &quot;Vaccination&quot;[Mesh]</td>
<td>76135</td>
<td>06:07:03</td>
</tr>
</tbody>
</table>
REFINE A SEARCH USING FILTERS

• Located at the left side of the search results

• Choose suitable filters depending on what you are looking for

• Select additional filters if necessary

• Most commonly used: Article Types, Language

- Article types
  Clinical Trial
  Meta-Analysis
  Practice Guideline
  Randomized Controlled Trial
  Review
  Systematic Reviews
  more ...

- Languages
  English
  more ...

Clear all

Choose additional filters
**Boolean Operators**

**AND** is used to indicate that both terms must be present
- *e.g.* caries AND sweets
  - *articles containing both caries and sweets*

![Venn Diagram](caries-sweets)

**OR** is used to indicate that either terms maybe present
- *e.g.* toothpaste OR dentrifices
  - *articles containing either toothpaste or dentrifices*

![Venn Diagram](toothpaste-dentrifices)
“Block Building”

Question: Is A related to B and C?

- Concept A AND Term ‘A1’ OR Term ‘A2’ OR Term ‘A3’
- Concept B AND Term ‘B1’ OR Term ‘B2’
- Concept C AND Term ‘C1’ OR Term ‘C2’ OR Term ‘C3’

- Concept A AND Concept B AND Concept C

(A1 OR A2 OR A3) AND (B1 OR B2) AND (C1 OR C2 OR C3)
Identify Keywords

Topic: Is vaccination related to autism?

Keywords:
- vaccination
- immunization
- vaccines

Concepts:
- autism
- autistic
- Kanner’s syndrome
SEARCH STATEMENT (KEYWORDS ONLY)

**Topic**

Is vaccination related to autism?

**Concepts**

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Concepts</th>
</tr>
</thead>
<tbody>
<tr>
<td>vaccination</td>
<td>autism</td>
</tr>
<tr>
<td>immunization</td>
<td>autistic</td>
</tr>
<tr>
<td>Vaccine*</td>
<td>Kanner’s syndrome</td>
</tr>
</tbody>
</table>

**Search Statement**

(vaccination OR immunization OR vaccine*) AND (autism OR autistic OR Kanner’s syndrome)
KEYWORD SEARCH

Using PubMed

Pubmed Tools
PHRASE SEARCHING “XXX”

Searches exact phrase.

Examples:
“peanut butter”
“drug delivery systems”
“single cell”

Brackets (xxx)

Used to combine concepts in a prescribed order in a search statement.

Examples:
(“managed care” AND doctor*) OR physician*
“managed care” AND (doctor* OR physician*)

(1 + 2) x 3 = 9
1 + (2 x 3) = 7
TRUNCATION *

Vaccine* - vaccine, vaccines…

Vaccin* - vaccination, vaccinations, vaccinator, vaccinating…

Vac* - vacation, vaccine… vacuum, vacuole…

Take Note: PubMed only searches the first 600 variations
**TIP 3: USE ENTRY TERMS FOR SYNONYMS**

If you need to expand your search consider these synonyms in keyword search.

- Disorder, Autistic
- Disorders, Autistic
- Kanner's Syndrome
- Kanner Syndrome
- Kanners Syndrome
- Autism, Infantile
- Infantile Autism
- Autism
- Autism, Early Infantile
- Early Infantile Autism
- Infantile Autism, Early
# MESH VS KEYWORD SEARCH

<table>
<thead>
<tr>
<th>Search</th>
<th>Add to builder</th>
<th>Query</th>
<th>Items found</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>#11</td>
<td>Add</td>
<td>Search (#9 AND #10)</td>
<td>679</td>
<td>01:43:37</td>
</tr>
<tr>
<td>#10</td>
<td>Add</td>
<td>Search (#4 OR #7)</td>
<td>40987</td>
<td>01:43:14</td>
</tr>
<tr>
<td>#9</td>
<td>Add</td>
<td>Search (#2 OR #6)</td>
<td>317079</td>
<td>01:42:34</td>
</tr>
<tr>
<td>#8</td>
<td>Add</td>
<td>Search (#6 AND #7)</td>
<td>562</td>
<td>01:41:25</td>
</tr>
<tr>
<td>#7</td>
<td>Add</td>
<td>Search (autism[Title/Abstract] OR autistic[Title/Abstract] OR Kanner's syndrome[Title/Abstract])</td>
<td>38509</td>
<td>01:40:11</td>
</tr>
<tr>
<td>#6</td>
<td>Add</td>
<td>Search (vaccination[Title/Abstract] OR immunization[Title/Abstract] OR vaccine*[Title/Abstract])</td>
<td>303153</td>
<td>01:39:45</td>
</tr>
<tr>
<td>#5</td>
<td>Add</td>
<td>Search (&quot;Vaccination&quot;[Mesh]) AND &quot;Autistic Disorder&quot;[Mesh]</td>
<td>128</td>
<td>01:35:58</td>
</tr>
<tr>
<td>#4</td>
<td>Add</td>
<td>Search &quot;Autistic Disorder&quot;[Mesh]</td>
<td>18682</td>
<td>01:35:37</td>
</tr>
<tr>
<td>#2</td>
<td>Add</td>
<td>Search &quot;Vaccination&quot;[Mesh]</td>
<td>76135</td>
<td>01:35:16</td>
</tr>
</tbody>
</table>

**MeSH + Keyword**

**Keyword**

**MeSH**
COMPARING KEYWORD, MESH AND MAJOR MESH SEARCHES

- Keyword: broadest, least precise, current
- MeSH: narrowest, more precise, slightly dated
SEARCH USING SUBJECT HEADINGS AND KEYWORDS

Keywords (added by author)

OR

MeSH terms (added by indexer)

All articles on that concept
What to do when you have too many results

1. Delete unnecessary MeSH and keywords *(More ≠ Good)*

2. Narrow your research question *(and apply search filters, e.g. age, gender, publication dates)*

3. Apply study type hedges / publication type filters *(to select for high-quality evidence)*
How to filter PubMed search results

Filters activated: Randomized Controlled Trial.
Why filter search results

- “Study type hedges” are used to select for high-quality evidence suited for the type of research question

- However, relying solely on publication type filters in databases, e.g. Randomized Controlled Trial [Publication Type] in PubMed, can lead to missed articles

- This problem is addressed with the Cochrane Highly Sensitive Search Strategy (RCT filter), adapted for PubMed, Embase and PsycINFO
How to review PubMed search results

Search results
Items: 1 to 20 of 405

1. Impact evaluation of different cash-based intervention modalities on child and maternal nutritional status in Sindh Province, Pakistan, at 6 mo and at 1 y: A cluster randomised controlled trial.

Fenn B1, Colbourn T2, Dolan C3, Pletzsch S3, Sangrasi M4, Shoham J4.

Abstract

BACKGROUND: Cash-based interventions (CBIs), offer an interesting opportunity to prevent increases in wasting in humanitarian aid settings. However, questions remain as to the impact of CBIs on nutritional status and, therefore, how to incorporate them into emergency programmes to maximise their success in terms of improved nutritional outcomes. This study evaluated the effects of three different CSI modalities on nutritional outcomes in children under 5 y of age at 6 mo and at 1 y.

METHODS AND FINDINGS: We conducted a four-arm parallel longitudinal cluster randomised controlled trial in 114 villages in Dadu District, Pakistan. The study included poor and very poor
DIRECT EXPORT 1 : PUBMED

Select records, select **Citation manager**, then **Create File**
DIRECT EXPORT 2: PUBMED

- Select **File**, then select **MEDLINE** format.
- When prompted to choose an import filter, type “**pub**” quickly, then choose PubMed.
How to end PubMed search
- **Review, Download & Save**

<table>
<thead>
<tr>
<th>History</th>
<th>Add to builder</th>
<th>Query</th>
</tr>
</thead>
</table>
How to adapt search to other databases

1. Adapt subject headings and free-text keywords accordingly
   (not all databases use subject headings, e.g. Scopus)

2. Translate search syntax
   (refer to Database syntax guide for PubMed, Embase and Cochrane)
## Checklist for search statements (adapted from PRESS)

<table>
<thead>
<tr>
<th>Category</th>
<th>Questions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Translation</strong></td>
<td>Is the search question translated well into search concepts?</td>
</tr>
<tr>
<td><strong>Operators</strong></td>
<td>Are there any mistakes in the use of Boolean or proximity operators?</td>
</tr>
<tr>
<td><strong>Subject headings</strong></td>
<td>Are any important subject headings missing? Have any irrelevant ones been included?</td>
</tr>
<tr>
<td><strong>Natural language</strong></td>
<td>Are any natural language terms or spelling variant missing? Have any irrelevant ones been included? Is truncation used optimally?</td>
</tr>
<tr>
<td><strong>Spelling &amp; syntax</strong></td>
<td>Does the search strategy have any spelling mistakes, system syntax errors, or wrong line numbers?</td>
</tr>
<tr>
<td><strong>Limits</strong></td>
<td>Do any of the limits used seem unwarranted? Are any potentially helpful limits missing?</td>
</tr>
</tbody>
</table>

SEARCHING EXERCISE
(20 MIN)

DEVELOPING SEARCH STRATEGY

The COCHRANE LIBRARY (via WILEY)

http://www.cochranelibrary.com/
How to begin Cochrane search
- Go to Advanced Search
(the 3S)
- Sign in, Seek help, Go to Search Manager
Two ways to input MeSH terms in Cochrane

1) Click on “m” in Search Manager

2) Click on “Medical Terms (MeSH) tab
How to input keywords in Cochrane

Type keywords in Search (By default, search is executed in “Title, Abstract, Keywords” fields)

Cochrane accepts Boolean operators in both upper and lower case
How to insert a new line in Cochrane

Cochrane accepts Boolean operators in both upper and lower case.
Cochrane allows you to explode all or selected “trees”
How to make use of “highlight orphan lines”

Rows 4, 7, 11 and 15 are orphaned.
How to review & download Cochrane search strategy

Click on number to view results

Click on printer to download search history as text file
How to filter Cochrane search results

Cochrane Database of Systematic Reviews

Issue 7 of 12, July 2017

There are 40 results from 9910 records for your search on #16 - #4 and #7 and #11 and #15 in Cochrane Reviews in the strategy currently being edited.

Sort by: Relevance: high to low

Select all | Export all | Export selected

1. Chromium picolinate supplementation for overweight or obese adults
   Hongliang Tian, Xiaohu Guo, Xiuyu Wang, Zhiyun He, Rao Sun, Sai Ge and Zongjiu Zhang
   Online Publication Date: November 2013

2. The WHO Health Promoting School framework for improving the health and well-being of students and their academic achievement
   Rebecca Langford, Christopher P Bonell, Hayley E Jones, Theodora Pouliou, Simon M Murphy, Elizabeth Waters, Kelli A Komro, Lisa F Gibbs, Daniel Magnus and Rona Campbell
   Online Publication Date: April 2014

3. Interventions for treating obesity in children
   Hiltje Oude Luttikhuis, Louise Baur, Hanneke Jansen, Vanessa A Shrewsbury, Claire O’Malley, Ronald P Stolk and Carolyn D Summerbell
   Online Publication Date: January 2009

4. School-based physical activity programs for promoting physical activity and fitness in children and adolescents aged 6 to 18
   Maureen Dobbins, Heather Husson, Kara DeCorby and Rebecca L LaRocca
   Online Publication Date: February 2013

5. Indoor residual spraying for preventing malaria
   Bianca Pluess, Frank C Tanser, Christian Lengeler and Brian L Sharp
   Online Publication Date: April 2010
How to review Cochrane search results

Community-responsive interventions to reduce cardiovascular risk in American Indians

<table>
<thead>
<tr>
<th>Title</th>
<th>Community-responsive interventions to reduce cardiovascular risk in American Indians</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author(s)</td>
<td>Jobe JB, Adams AK, Henderson JA, Karanja N, Lee ET, Walters KL</td>
</tr>
<tr>
<td>Source</td>
<td>Journal of primary prevention</td>
</tr>
<tr>
<td>Date of Publication</td>
<td>2012</td>
</tr>
<tr>
<td>Volume</td>
<td>33</td>
</tr>
<tr>
<td>Issue</td>
<td>4</td>
</tr>
<tr>
<td>Pages</td>
<td>153-9</td>
</tr>
<tr>
<td>Medical Subject</td>
<td>Adult; Cardiovascular Diseases [ethnology]; *Cardiovascular Diseases [prevention &amp; control]; Child; Child, Preschool; Consumer Participation [methods]; Diabetes Complications [ethnology]; Diabetes Complications [prevention &amp; control]; Diabetes Mellitus [ethnology]; Diabetes Mellitus [prevention &amp; control]; Female; *Health Behavior [ethnology]; *Health Promotion [methods]; Humans; *Indians, North American [statistics &amp; numerical data]; Infant, Male; Obesity [complications]; Obesity [ethnology]; Obesity [prevention &amp; control]; Randomized Controlled Trials as Topic; Risk Factors; Smoking [adverse effects]; Smoking [ethnology]; Smoking [prevention &amp; control]; United States [epidemiology]</td>
</tr>
<tr>
<td>Accession Number</td>
<td>PUBMED 22983753; EMBASE 22983753</td>
</tr>
<tr>
<td>Cochrane Group Code</td>
<td>SR-TOBACCO</td>
</tr>
<tr>
<td>Publication Type</td>
<td>Journal Article; Review</td>
</tr>
<tr>
<td>ID</td>
<td>CN-00868152</td>
</tr>
</tbody>
</table>
DIRECT EXPORT: COCHRANE

1. Select records to be exported and click on **Export selected** or **Export all**

2. Choose your export options and click on **Export Citation**
DIRECT EXPORT: COCHRANE

3. Import file into EndNote library

https://youtu.be/QHXWaAZZBqE
DEVELOPING SEARCH STRATEGY

CINAHL (via EBSCOhost)
How to begin CINAHL (via EBSCO) search (the 3S)

- Sign in, Seek help, go to Advanced Search

Search Options

Search Modes and Expanders

- Search modes
  - Boolean/Phrase
  - Find all my search terms
  - Find any of my search terms
  - SmartText Searching

- Apply equivalent subjects

- Apply related words

- Also search within the full text of the articles
How to input CINAHL Headings

1. Enter the term "child" into the search field.
2. Select "MH Exact Subject Heading".
3. Click the "Search" button.

The term "Child" is then searched with all subheadings included.

- Includes terms like:
  - Child, Abandoned
  - Child, Adopted
  - Child, Disabled
  - Child, Foster
  - Child, Gifted
  - Child, Hospitalized
  - Child, Institutionalized

- Each two-letter code represents a subheading, e.g., Child, Abandoned.
Subject Headings may differ between databases

CINAHL may suggest alternative Subject Heading

CINAHL Heading may differ from MeSH
How to input keywords in CINAHL

In the search bar, input the search terms using logical operators. For example, you can search for "child* OR adolescen* OR youth*". This will return results related to children, adolescents, and youth.

You can also use Boolean operators like AND, OR, and NOT to refine your search. For instance, you might use "child* AND youth*" to find articles that specifically mention both children and youth.

The search results will be displayed in the search history/alerts section. You can select/deselect searches, view results, and edit them as needed.

Remember to check the search options and results to ensure they meet your research needs.
How to combine CINAHL Headings and keywords

Search History/Alerts

Search with AND

Search with OR
How to review & save search strategy in CINAHL

### Search History/Alerts

<table>
<thead>
<tr>
<th>Search ID#</th>
<th>Search Terms</th>
<th>Search Options</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>S4</td>
<td>S1 OR S2 OR S3</td>
<td>Search modes - Boolean/Phrase</td>
<td><img src="794,540" alt="View Results" /></td>
</tr>
<tr>
<td>S3</td>
<td>AB child* OR adolescent* OR youth*</td>
<td>Search modes - Boolean/Phrase</td>
<td><img src="265,156" alt="View Results" /></td>
</tr>
<tr>
<td>S2</td>
<td>(MH &quot;Adolescence+)&quot;)</td>
<td>Search modes - Boolean/Phrase</td>
<td><img src="385,762" alt="View Results" /></td>
</tr>
<tr>
<td>S1</td>
<td>(MH &quot;Child+&quot;)</td>
<td>Search modes - Boolean/Phrase</td>
<td><img src="492,589" alt="View Results" /></td>
</tr>
</tbody>
</table>
How to filter search results in CINAHL

- Click on "Page Options" to refine search results.
- Select "Detailed" for more information.
- Use "Result Format" to choose "Title Only".
- Adjust "Results per page" to filter the number of results displayed.
- Choose "3 Column" layout for a more organized view.

Example search results:

1. Knowledge, Attitude and Practices among Mothers Regarding Childhood Obesity at Kuantan, Malaysia.
2. "Are Thai children and youth sufficiently active? Prevalence and correlates of physical activity from a representative cross-sectional study".
3. Family Dinner Frequency is Inversely Related to Mental Disorders and Obesity in Adolescents: the CASPIAN-III Study.
4. The effectiveness of the COPE healthy lifestyles TEEN program: a school-based intervention in middle school adolescents with 12-month follow-up.
DIRECT EXPORT: CINAHL

1. Add records to the folder
DIRECT EXPORT: CINAHL

2. Click on Folder to export the records
DIRECT EXPORT: CINAHL

3. Click on Folder to export the records

4. Double click the downloaded file or click “Open with” to transfer records to your EndNote library
DEVELOPING SEARCH STRATEGY

PsycInfo (via Ovid)
PsycInfo (Ovid)

SEARCH INTERFACE

Tips: Use Advanced Search for Subject Heading search and Multi-field Search for keywords search
How to search for Subject Heading in PsycInfo (Ovid)

Thesaurus for Injections

Combine with: [ ] [ ] Continue

1. Injections

<table>
<thead>
<tr>
<th>Injections</th>
<th>3083</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Broader Terms]</td>
<td></td>
</tr>
<tr>
<td>Drug Administration Methods</td>
<td>4542</td>
</tr>
<tr>
<td>[Narrower Terms]</td>
<td></td>
</tr>
<tr>
<td>Intramuscular Injections</td>
<td>238</td>
</tr>
<tr>
<td>Intraperitoneal Injections</td>
<td>186</td>
</tr>
<tr>
<td>Intravenous Injections</td>
<td>1222</td>
</tr>
<tr>
<td>Subcutaneous Injections</td>
<td>200</td>
</tr>
<tr>
<td>[Related Terms]</td>
<td></td>
</tr>
<tr>
<td>Drug Self Administration</td>
<td>1992</td>
</tr>
</tbody>
</table>

Search History (1)

# ▲ Searches

1 exp injections/
How to input keywords in PsycInfo (Ovid)

Basic Search | Find Citation | Search Tools | Search Fields | Advanced Search | Multi-Field Search

1 Resource selected | Hide | Change

PsycINFO 1806 to May Week 1 2018

Search History (5)

<table>
<thead>
<tr>
<th>#</th>
<th>Searches</th>
<th>Results</th>
<th>Type</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>exp injections/</td>
<td>4852</td>
<td>Advanced</td>
<td>Display Results</td>
</tr>
</tbody>
</table>
| 2 | (jet OR "tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-free" OR " needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR needle) OR (jet OR "tip" OR "needle-
# How to combine Subject Headings and keywords in PsycINFO (Ovid)

## Search History (8)

<table>
<thead>
<tr>
<th># ▲</th>
<th>Searches</th>
<th>Results</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>exp injections/</td>
<td>4852</td>
<td>Advanced</td>
</tr>
<tr>
<td>2</td>
<td>(jet or &quot;j tip&quot; or &quot;needle-free&quot; or &quot;needle free&quot; or &quot;no needle&quot; or &quot;needleless&quot; or &quot;needle-less&quot;).ti. or (jet or &quot;j tip&quot; or &quot;needle-free&quot; or &quot;needle free&quot; or &quot;no needle&quot; or &quot;needleless&quot; or &quot;needle-less&quot;).ab.</td>
<td>797</td>
<td>Advanced</td>
</tr>
<tr>
<td>3</td>
<td>exp LIDOCAINE/</td>
<td>432</td>
<td>Advanced</td>
</tr>
<tr>
<td>4</td>
<td>(lignocaine or lidocaine or xylocaine).ti,ab.</td>
<td>1099</td>
<td>Advanced</td>
</tr>
<tr>
<td>5</td>
<td>(lignocaine or lidocaine or xylocaine).ti. or (lignocaine or lidocaine or xylocaine).ab.</td>
<td>1099</td>
<td>Advanced</td>
</tr>
<tr>
<td>6</td>
<td>1 or 2</td>
<td>5646</td>
<td>Advanced</td>
</tr>
<tr>
<td>7</td>
<td>3 or 4</td>
<td>1110</td>
<td>Advanced</td>
</tr>
<tr>
<td>8</td>
<td>6 and 7</td>
<td>63</td>
<td>Advanced</td>
</tr>
</tbody>
</table>
How to review & save search strategy in PsycINFO (Ovid)

The effects of preoperative oral pregabalin and perioperative intravenous **lidocaine** infusion on postoperative morphine requirement in patients undergoing laparotomy. [References].

Zengin, Senniye Ulgen; Saracoglu, Ayten; Eti, Zeynep; Umuroglu, Tumay; Gogus, Fevzı Yılmaz.


Objectives: To evaluate and compare the effects of preoperative oral pregabalin and perioperative intravenous **lidocaine** infusion on postoperative morphine requirement, adverse effects, patients' satisfaction, mobilization, time to first defecation and time to discharge in patients undergoing laparotomy. Methods: Eighty patients (18 to 65 years of age) undergoing elective laparotomy were randomly divided into four groups (n = 20 in each group): group C, placebo capsules and normal saline infusion perioperatively (control); group L, placebo capsules and **lidocaine** 1 mg/kg intravenous bolus dose followed by 2 mg/kg/h infusion until skin closure; group P, 150 mg oral pregabalin and normal saline infusion perioperatively; and group PL, 150 mg oral pregabalin and **lidocaine** 2 mg/kg/h infusion until skin closure. Hemodynamic parameters, visual analogue scale (VAS) scores, analgesic consumption, side effects, time to mobilization, time to first defecation, time to discharge and patients' satisfaction were recorded. Results: VAS scores of group L, group P and group PL were lower than group C (P < 0.05). Morphine consumption of group P and group PL was lower than group C (P < 0.05). Incidence of nausea in group C was higher than group L and group PL. Time to first defecation and mobilization were shorter in group L and group PL compared with group C (P < 0.05). Conclusion: Preoperative oral pregabalin and perioperative intravenous **lidocaine** infusion decreased postoperative VAS scores. Preoperative oral pregabalin decreased morphine requirement and perioperative intravenous **lidocaine** infusion hastened gastrointestinal motility and mobilization, and decreased the incidence of nausea in patients undergoing laparotomy. Therefore,
<table>
<thead>
<tr>
<th>#</th>
<th>Searches</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>exp injections/</td>
</tr>
<tr>
<td>2</td>
<td>(jet or &quot;jet tip&quot; or &quot;needle-free&quot; or &quot;needle free&quot; or &quot;needleless&quot; or &quot;needle-less&quot;) t.l. or (jet or &quot;jet tip&quot; or &quot;needle-free&quot; or &quot;needle free&quot; or &quot;needleless&quot; or &quot;needle-less&quot;) a.b.</td>
</tr>
<tr>
<td>3</td>
<td>exp LIDOCAINE/</td>
</tr>
<tr>
<td>4</td>
<td>lignocaine or lidocaine or xylocaine), t.l, a.b.</td>
</tr>
<tr>
<td>5</td>
<td>lignocaine or lidocaine or xylocaine), t.l. or (lignocaine or lidocaine or xylocaine).a.b.</td>
</tr>
<tr>
<td>6</td>
<td>1 or 2</td>
</tr>
<tr>
<td>7</td>
<td>3 or 4</td>
</tr>
<tr>
<td>8</td>
<td>6 and 7</td>
</tr>
</tbody>
</table>

**Search Name:**

- jet injection lidocaine

**Comment (Optional):**

- Permanent

**Type:**

- Save
EXPORT PsycInfo (Ovid) CITATIONS TO ENDNOTE

1. The effects of preoperative oral pregabalin and perioperative intravenous morphine requirement in patients undergoing laparotomy. [References].
Zengin, Senniye Uğen; Saracoglu, Ayten; Eti, Zeynep; Umuroğlu, Tumay; Gogus, Feyzi; Ayvaz, Vural; Zengin, Ata; Pehlivan, Cihan; Akaç, Mehmet; Ün, Enver; et al. Pain Research & Management. Vol.20(4), 2015, pp. 179-182.

Objectives: To evaluate and compare the effects of preoperative oral pregabalin and perioperative intravenous morphine reduction on postoperative morphine requirement, adverse effects, patients satisfaction, movement, and early discharge in patients undergoing laparotomy. Methods: Eighty patients (18 to 65 years) were randomly divided into four groups (n = 20 in each group): group C, placebo capsules and saline intravenous infusion perioperatively (control); group L, placebo capsules and 1 mg/kg intravenous lidocaine infusion until skin closure; group P, 150 mg oral pregabalin and normal saline intravenous infusion perioperatively, and group A, 150 mg oral pregabalin, intravenous lidocaine, and normal saline perioperatively. Results: There were no significant differences between the groups in terms of patient satisfaction, pain scores, and movement. Conclusion: Preoperative oral pregabalin reduces perioperative morphine requirement and adverse effects in patients undergoing laparotomy.
MANAGE SEARCH RESULTS

Step 1: Grouping
Step 2: Annotating the records
Step 3: Removing the duplicates
Step 4: Exporting the Endnote library to Excel
**STEP 1: GROUPING**

Create folders to group (categorize) references

1. Group set and custom groups

2. Smart Groups

3. Create From Groups
RECORD NUMBERS IN PRISMA CHART

433 records identified
Cochrane (n=56), CINAHL (n=20), EMBASE (n= 208), PubMed (n=35), PsycINFO (n=1), Scopus (n=35) and ProQuest Dissertations and Theses (n=78)

5 additional records identified from reference lists

37 records were curated using ENDNOTE program to remove duplicates

401 articles found for screening

Reasons for 331 records exclusion:
- Irrelevant based on title (n=149)
- Irrelevant based on abstract (n=182)

Reasons for 56 full-text articles exclusion:
- Non-experimental studies (n=8)
- Protocols (n=5)
- Non-diabetic perinatal women (n=8)
- No application of technology (n=8)
- No self-monitoring component (n=8)
- Qualitative outcomes (n = 1)
- Outcomes are not clear or insufficient (n=2)
- No outcomes (n=8)
- Technology on diabetes screening reminder (n=3)

70 of full-text articles assessed for eligibility

n=14 publications (12 studies) included for meta-analyses (9 Randomized Control Trials and 3 Control Clinical Trials)
STEP 2: ANNOTATING THE RECORDS

1. Tools -> Change/Move/Copy Fields...

The display fields...

2. Edit -> Preferences...

- PubMed 11-5-16 Journal Article 2013 Youth work se
- CINAHL 12-5-16 Journal Article 2009 Worth a look
- Scopus Journal Article 2008 World Federat
- PubMed 11-5-16 Journal Article 2013 Work-site heal
- Web of Science 1... Journal Article 2013 Working Mem
- PubMed 11-5-16 Journal Article 2009 Work, recover
- Scopus Journal Article 2015 Women's expe
- ABI/INFORM Co... Journal Article 2012 Why do some
STEP 3: REMOVING THE DUPLICATES

1. Remove Duplicates

References > Find Duplicates

2. Delete Unwanted References

Select references then

References > Move References to Trash

*** Note: To delete References permanently,

References > Empty Trash
STEP 4: SCREENING IN ENDNOTE

Tools for Managing a Systematic Review
http://guides.library.cornell.edu/c.php?g=459012&p=3142087
BACKUP AN ENDNOTE LIBRARY

1. Save the complete Library to a single compressed file (.enlx), including .DATA folder.

2. To backup: **File > Compressed Library**

3. To decompress: **double click file**
LOOKING FOR FULL-TEXT?

- Search in Google Scholar
- Other resources
- Alternatively
- Only if proxy failed
- Only if FindMore@NUSL failed

Library proxy bookmarklet
FindMore@NUSL
LINC
SEARCHING EXERCISE
(20 MIN)
Please submit online feedback at:

Group 1 (9 – 11 am):
https://mysurvey.nus.edu.sg/EFM/se/547D231548BADD85

Group 2 (2 – 4 pm):
https://mysurvey.nus.edu.sg/EFM/se/547D231559EC9716